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USER GUIDE 

ABOUT THIS CHAPTER 
This chapter contains descriptions of all the functions of 
Imposition Publisher. It is most useful as a reference. To get a 
quick start on doing actual work, refer to the Quick Start booklet. 
The material in this chapter is organised into the following 
sections: 

File Lists 

Creating the list of files that Imposition Publisher will use. 

Impositions 

Creating and using a page-layout template for use with a File List. 

Flatwork 

Creating and using a flatwork template to position pages from the 
File List accurately on the output sheet. 

Print Marks 

Setting up standard print marks and creating custom print marks 
from EPS and PDF files. Saving commonly used settings as named 
print mark sets. 

Device Setup & Alignment 

Setting up printer devices and aligning the output exactly as 
required. Saving settings as a named print device. 

Printing & Previewing 

Printing and previewing jobs. Setting print options. Details of 
Media Saving and Facing Pages Print. 

Preferences 

General preferences for Imposition Publisher. 
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License Dialog 

The different versions of Imposition Publisher. 

Menus & Shortcut Keys 

A list of all the menus and the shortcut keys to help speed your 
Imposition Publisher workflow. 

FILE LISTS 
Imposition Publisher needs to know which files to work on. This 
information is provided by a File List. This section is divided into 
the following parts: 

• Creating, Saving and Opening File Lists 

• The File List Window 

• The File Selection Dialog 

• The File Info Dialog 

• Colour and File Lists 

• Limitations of the File List 
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Important Notes about File Lists 

Before starting, be sure that the files you want to use are correctly 
created. For PostScript files make sure you use the Desktop 
publishing program’s crop marks option and include any 
necessary fonts. For PDF files make sure that the correct settings 
are used to preserve font and image information. See the appendix 
Creating PostScript and PDF Files for more guidance. 

1. Imposition Publisher has the ability to mix different types of 
PostScript in one single job. All the popular types of PostScript 
can be mixed. However, not all drivers have this ability. If the 
PostScript file type can be mixed, then after adding a file to the 
File List, the PostScript Type popup remains enabled. If the 
driver is a non-mixing driver, the popup will become disabled 
(greyed out), thus allowing only files of that specific type to be 
used in that File List. 

2. Imposition Publisher ignores the folio numbers in the file 
itself. It treats the first page of the first file in the File List as 
page 1, the next page as page 2, etc. 

3. Imposition Publisher automatically adds blank pages at the 
end of the last file if required when printing. The Add Blank 
feature only needs to be used to add blank pages elsewhere in 
the File List. 

Creating, Saving and Opening File Lists 

Creating a File List 

1. Select New File List… from the File menu. This will bring up 
the File List window: 
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2. Click Add Files… to open the file selection dialog box:  

 

3. Select the files you want to work on (Ctrl-click to select 
multiple files) and click Open to add them to the File List. 

 When loading files, Imposition Publisher extracts important 
information, such as how many pages, whether they are 
colour separated, the position of all included fonts and 
images, etc. This could take a few seconds for larger files.  

 

4. Add any more files you want to work on. Again Imposition 
Publisher scans the files to extract information from each file. 
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5. If necessary, you can change the order of files and pages in the 
File List by dragging them within the list area. 

(See The File List Window section below for a full explanation of 
the File List window.) 

Saving a File List 

If you do not need to use the File List immediately, you can save it 
for later use. This will save time because the information from the 
files does not need to be extracted a second time. To do this: 

1. Select Save from the File menu. 

2. Enter a file name and click Save. 

 

Opening a File List 

To open a File List: 

1. Select Open… from the File menu and select the File List you 
wish to open.  
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This will bring up the File List as it was when last saved: 

 

Imposition Publisher checks that the files saved in the File List are 
still present in their correct locations. If not, Imposition Publisher 
will prompt you to locate and add the files again: 

 

OK  

Opens a standard file selection dialog enabling you to select the 
missing file. 

Force a rescan of the files 
You can choose to load a file without rescanning it. This preserves 
blanks and moved pages in a saved file list. Only do this if you are 
certain that the PostScript file has not changed in any way. 

Use the same folder to update other missing files 
If this is checked, then any other missing files in the same folder 
will be reloaded. 

Cancel  

Cancels the opening the File List altogether. 
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Delete File 

Removes the file from the File List. 

The File List Window 

On opening a File List a window similar to the following appears: 

 

File List Buttons 

Add Files… (Alt A) 

This button is used to add files to the File List.  

You can also add files by drag and drop. Drag files from a 
Windows Explorer window and drop them on the file list 
window. 

Add Blank (Alt B) 

Add a blank page to the File List. Use Clear from the Edit menu to 
delete blank pages from the File List. 

If the currently selected item is a file, then a blank page is inserted 
at the top of the file. However, if the currently selected item is a 
page, a blank page is always added after that page. 
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Adding a blank page directly into a closed file: 

 

You can see the blank page when the file is opened. 

 

Adding a blank page after a specific page. In this case, the blank 
has been added after page 3. So, Page 3 was highlighted and the 
Add Blank button clicked. 
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Important: Imposition Publisher will automatically add blank 
pages at the end of the last file if required when 
printing. Add Blank only needs to be used to add 
blank pages elsewhere in the File List. 

Replace File… (Alt F) 

Replace the currently selected file with another one. The file 
selection dialog is displayed, allowing the replacement file to be 
selected. 

Replace Pages… (Alt P) 

Replace the currently selected page with any other page in the File 
List. This allows last minute corrections to be made without 
having to regenerate all the files in a job. 

Format Pop-up 

Imposition Publisher handles many file formats by using a special 
driver file for each file format. Every Desktop publishing program 
produces slightly different flavours of PostScript files, so 
Imposition Publisher has a different driver to work with every 
supported program.  

Imposition Publisher has a special driver called AutoDetect that is 
able to recognise any supported PostScript file. The Format popup 
menu can be used to select an appropriate driver or, for ease of 
use, can be left on the AutoDetect setting. 
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Important: Imposition Publisher has the ability to mix different 
types of files in one single job. All the most popular 
types of PostScript can be mixed. However, not all 
drivers have this ability. If the PostScript file type can 
be mixed, then after adding a file to the File List, the 
Format popup remains enabled.  

 If the driver is a non-mixing driver, the popup will 
become disabled (greyed out), thus allowing only files 
of that specific type to be used in that File List. 

File List Icons 

Tree Control  
The plus sign (+) inside a small box, which appears to the left of 
each file in the File List, allows you to expand the file in order to 
display all the pages within the file.  

Where just the file name is visible, this is known as a closed file. 

 

An expanded file is referred to as an open file. 

 



Chapter 2  User Guide 

31 

Each page can be further expanded to show its individual colour 
separations. 

 

Toggle On/Off 
The grey diamond next to the tree control allows you to switch 
files and pages on and off. If pages are switched off, they are 
ignored when printing. However, if individual colour separations 
are switched off within a page, they will be replaced with blank 
pages where necessary.  

For example, to switch off all pages of a file, click the file’s toggle 
icon. 
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Or, to switch off a single page, click the toggle icon for that page. 

 

Information Icon 
This information button, on the right side of the file name, allows 
you to view more information about the file. 

 

See The File Info Dialog below for more details. 
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The File Selection Dialog 

Clicking on Add Files… brings up a file selection dialog: 

 

Open (return key)  
Add the currently selected file to the File List and return to the File 
List window. The same result can be achieved by double clicking 
on the file. You can select multiple files in this dialog by Ctrl-
clicking. 

The File Info Dialog 

The File Info dialog can be used to change the trim page size and 
margins associated with any file in the file list. If the file was 
created with crop marks, Imposition Publisher can establish the 
page size and margins exactly. For files created without crop 
marks you may need to enter the page size manually. 

 

Units 

Use this popup to change the units for this dialog.  



User Guide Chapter 2 

34 

Page Size 

For the purposes of imposition, all pages take on the same trim 
page size as the first file in the File List. 

If you are using Flatwork or the Media Saving print option, every 
file in the File List can have a different page size. This is the 
default behaviour. If you want every page to use the same page 
size, select Inherit Page Size from the List menu. 

Size 
This popup displays the document page size. It is this size that 
Imposition Publisher will use as the trim page size for printing 
impositions.  

Note:  Do not adjust this if the file was created with crop marks. 

Custom can be used for any non-standard page sizes.  

Width 
The width of the document page. For files without crop marks you 
may need to enter the page width here. For files with crop marks 
the width appears automatically. 

Height 
The height of the document page. For files without crop marks 
you may need to enter the page height here. For files with crop 
marks the height appears automatically. 

Orientation 
Use this button to set the orientation of the pages to either Portrait 
or Landscape. Imposition Publisher can usually establish the 
orientation from the file itself. 

Double Page Spreads 
Use this check box to tell Imposition Publisher if there are double-
page spreads within the file. Most of the time Imposition Publisher 
can establish this from the file but in some cases you will need to 
tell it explicitly. 
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Note 
Typically, a double-page spread will be twice the width of a 
normal page. So for an A4 portrait document, a double page 
spread will be an A3 landscape sized page.  

If the first page in the document is not a double page spread then 
Imposition Publisher can automatically find them by comparing 
the page width of subsequent pages with the first page. 

If the first page is a double page spread you may need to change 
the page setup to that of a normal page. I.e. change the page size 
from A3 to A4 and the orientation from landscape to portrait. 
Imposition Publisher can then automatically find the other double 
page spreads by comparing the page width of subsequent pages 
with the first page, now set at A4. 

Double page spreads count as two pages in the File List. 

Margins 

This option is used to adjust the position of the page contents 
within the page area. This may be necessary if the original file was 
not created with crop marks. Thise adjustment can be different for 
odd and even pages. 

Position 
This popup menu is used when entering a manual page size. 
Imposition Publisher uses this information to position the 
document page within the page size detected from the file. 

First Page 
Select whether the first page in the file is an Odd page or Even 
page. 

Odd Page 
Enter the horizontal offset that should be applied to all odd pages 
in the file. 

Even Page 
Enter the horizontal offset that should be applied to all even pages 
in the file. 
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Bottom 
Enter the vertical offset that should be applied to all pages (odd 
and even) in the file. 

Inherit Margins 

If margin settings need to be the same for all files, select Inherit 
Margins from the List menu. 

If this option is on, Imposition Publisher will apply the margin 
settings to all subsequent files. This is particularly useful if you are 
adding many files from the same source that all need the same 
margin settings. 

You can switch the Inherit Margins option off at any point using 
the List menu. 
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Colour and File Lists 

When a file is added to the File List, Imposition Publisher will 
automatically find the colour and position of individual pages in 
the file. If it cannot, or the file is not colour separated, then all 
pages in the file are assumed to be black.  

To review the colour information of the File List, open the file and 
pages in the File List by clicking their triangular icons. This will 
reveal the colour separations found for each page number. 

 

If you need to change this colour information, select Edit 
Colours… from the List menu. This displays the Edit Colours 
dialog: 

 

Important: You should add all the files you wish to use, add any 
blank pages and toggle the required pages on or off 
before using this dialog. 
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The dialog displays all the colour separations in the file list on the 
left. 

If you need to change the colour information for the file list 
because the list of colours is incorrect, you can change the name 
and position of each colour separation. 

Add 

Type the new colour separation name and click Add to add the 
new colour name to the list.  

To assign this new colour name, select the separations in the file 
list, then choose the new colour name from the Separation Colour 
submenu on the List menu. 

 

It is simple to change the name of all separations of one particular 
colour. 

1. Add the new colour name into the colour list. 

2. Alt-click the plus sign to the left of the first file to open all the 
pages and separations in the file list. 

3. Choose Select All (Ctrl A) from the Edit menu to select all 
files, pages and separations. 

4. From the List menu, choose Reduce Separation To, and then 
the colour you want to replace from the submenu. 

5. From the List menu, choose Separation Colour, and then 
choose the new colour from the sub menu. 
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IMPOSITION 
Imposition is the program’s most powerful feature. The goal is to 
output desktop publishing files to plate, film or a digital printer 
quickly and efficiently.  

The ideal is to be able to output Imposition layouts in one piece. 
However, with smaller/narrower imagesetters this is not always 
possible. Imposition Publisher has a built-in tiling feature which 
automatically prints the job in sections. Using an imposition, even 
when output has to be tiled, is much faster than stripping and 
plate making manually. As imposition layouts can be created and 
saved for later use, the effort required to produce finished masters 
or flats is dramatically reduced.  

Imposing files is simple with Imposition Publisher. If you already 
use complex DTP programs Imposition Publisher will help you 
save film, time and labour costs instantly.  

This section is divided into the following sections: 

• Creating, Saving and Opening Impositions 

• The New Imposition Dialog 

• The Imposition Window 

• The Imposition Setup Dialog 

• The Imposition Page Position Palette 

Creating, Saving and Opening Impositions 

Important: If you find you are sitting in front of your computer 
typing in hundreds of numbers, then you are doing it 
wrong! 

Creating New Impositions 

Before creating a new imposition template you need to know the 
following: 
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• Which kind of imposition to use: Perfect Bound, Saddle 
Stitched, Coming and Going or Cut and Stack. 

• How many rows and columns of pages there are in a block 
(flat). 

• The page order for the imposition template. 

• The number of blocks in the imposition For a typical situation, 
there will be one plate for the front of the paper (Front) and 
one plate for the back of the paper (Back). This means, 
typically, that there are two blocks in the imposition template. 

• The orientation of the pages. 

• The trims, or distances between pages, and any creep or bottle 
values required. 

When you have this information, you are ready to create your 
imposition. 

Note:  Imposition Publisher will automatically generate all of the 
blocks from the first two for the whole job. So whether 
your job is 16 pages or 1600 pages you still only need to 
create a 2-block imposition. 

 For example, if a perfect bound imposition template has 
eight pages in two blocks, the pages on block 1 are 
ordered 5, 4, 8, 1 and on block 2 are 3, 6, 2, 7, then the third 
imposed block will automatically contain pages 13, 12, 16, 
9 and the fourth block pages 11, 14, 10, 15. 
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1. Select New Imposition… from the File menu. The New 
Imposition dialog appears: 

 

2. Enter the appropriate information for the new imposition. (See 
The New Imposition Dialog below). 

3. Click OK. 

This opens the Imposition window: 

   

This is a representation of the imposition template. 
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4. Enter the page order. Click the first page and type the page 
number. Use the tab key or the mouse to take you to the next 
page. The page numbers are entered automatically on the 
second block. To see the second block, click the horizontal 
scroll bar. 

  

5. Select the orientation of the rows. This is done by clicking on 
the Orientation Arrows to the left of the rows. 

   

6. Select the orientation of individual pages. If you require 
certain pages in a row to be of a different orientation from the 
Orientation Arrows then select the page, then select Rotate Page 
from the Imposition menu. The page will rotate in increments 
of 90°. 

7. Select the Units you wish the trims to be measured in. 

8. Click the Trims checkbox on to display the trim values 
between rows and columns of pages. Select the box containing 
the trim value and type the value that you require. 
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Note:  The width and height of the block is displayed, taking into 
account the page size, trims and the crop mark length. The 
Block Width and Block Height provide a useful check to 
see if the imposition will print in one piece on your output 
device or whether it will have to be tiled.  

9. Enter the Edge Trims. This is the space between the crop 
marks and the individual edge of the block. 

   

10. Set the Mirror Trims flag. Typically, the imposition you will 
be creating will be made up of two blocks, a front and back, as 
you will want to print on both sides of the sheet of paper. In 
this case the vertical trims on the block that print on the back 
will be in reverse order. Setting the Mirror Trims flag on will 
reverse the vertical trims on the back. 
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11. Enter any Page Creep. Starting with the outside pair of pages 
of a section that has the largest trim value, the trim value 
between pairs of pages is progressively reduced by the creep 
value as they move towards the centre pair of the section. 

12. Enter any Bottling value. The value entered here is for whole 
sections. Starting with the outside pair of pages of a section, 
which is rotated by the bottle value, pairs of pages are rotated 
progressively less so that the centre pair of pages in a section 
has no bottle angle at all. 

Important:  If either creep or bottle is required, the pages in the 
imposition must be in Printers Pairs. 

Once you have created the imposition and all the settings are 
correct, you should save the imposition. 

Saving Impositions 

1. Select Save in the File menu. 

2. Navigate to any appropriate folder and enter an appropriate 
filename. Click  Save. 

  

See Opening Impositions below on how to use this imposition 
again. 
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Opening Impositions 

1. Select Open… from the File menu.  

2. Navigate to the appropriate folder, select the imposition and 
click Open. 

  

The previously saved imposition will be opened: 

   

For further details on the standard impositions that come with the 
program see Appendix A. 

Important: If you select an imposition that came with the 
software, you should check that the trim values match 
your requirements. 
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The New Imposition Dialog 

To set up a new imposition, select New Imposition… from the File 
menu. The New Imposition dialog appears: 

 

Imposition Type 

The different imposition types available are Perfect Bound, Saddle 
Stitched - standard and webbed inset - Coming and Going and Cut 
and Stack. 

See Kinds Of Finishing in the Introduction for a complete 
explanation of these different types of imposition schemes. 

Pages Across 

The number of columns in a block. The default is 2.  

Pages Down 

The number of rows of pages in a block. The default is 2.  

No. of Blocks 

The number of blocks that make up the complete imposition. In 
most cases, the imposition is made up of a front and a back; 
therefore the default is 2. 

Increment Value 

The value by which each page in a Cut and Stack imposition 
layout is increased for each subsequent block. Normally this 
should be set to 1 for single sided work and to 2 for double-sided 
work. 
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The Imposition Window 

 

Page Order 

When Page Order is checked, the order of the pages can be entered 
or edited. 

Automatic Numbering for Cut and Stack Impositions 

To avoid having to calculate the page numbers for a Cut and Stack 
imposition, enter the page order 1, 2, 3, 4, etc. on the 1st block. 
Imposition Publisher will then calculate the page numbers 
automatically, based on the total number of pages that are printed. 

Trims 

When Trims is checked, the trims between the pages can be 
entered or edited. 

Orientation Arrows 

The orientation of a row can be flipped by clicking on the 
Orientation Arrow at the beginning of the row. 

Mirror Pages 

When this is checked, Imposition Publisher will automatically 
enter the page numbers on the second block based on the values 
entered on the first block. 
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Mirror Trims 

Normally for a front and back situation, the order of the trims 
between the columns of pages is reversed for the back. When 
Mirror Trims is selected, Imposition Publisher will reverse the 
order of the trims for the back. 

Edge Trims 

Edge Trims are used to control the distance between the four edges 
of the block and the start of the crop marks. 

Block Dimensions 

The minimum width and depth of the block is displayed, 
including the edge trims and crop marks, if appropriate.  

Creep 

Enter any page Creep rate. Starting with the outside pair of pages 
of a section, the trim value between pairs of pages is progressively 
reduced by this value as they move towards the centre pair of the 
section. If creep is required, the pages in the imposition must be in 
printers pairs. 

Bottle 

When folding a piece of paper in half and then in half again so that 
the four corners meet, it is impossible to get the corners to line up 
exactly. This is because the paper has a certain thickness (bulk). 
The outer pages in this case will be rotated around the folded 
corner. To compensate for this bulk, when using thick paper or 
large impositions, the pages need to be rotated around the points 
where the folds meet. The angles these pages are rotated through 
to compensate for bulk are called Bottle Angles.  

The value entered here is the maximum for the whole section. 
Starting with the outside pair of pages of a section, which is 
rotated by the Bottle value, pairs of pages are rotated 
progressively less so that the centre pair of pages in a section has 
no bottle angle at all. If bottling is required, the pages in the 
imposition must be in printers pairs. 
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Note If these Creep and Bottle features do not meet your needs, 
you can position every page individually using the Page 
Positions dialog. 

Page Orientation 

You can rotate any individual page in increments of 90° by 
selecting Rotate Page from the Imposition menu. You can also 
rotate a page by clicking on the small arrow icon inside the page 
or by using the keyboard shortcut Ctrl R.  

This is especially useful for impositions in which the spine is on 
the head of a page, for example, calendars. In such cases, the back 
of a page may be printed upside down in relation to the front of 
the page. Rotate Page allows you to rotate individual pages on a 
block, as necessary. 

To flip a page in the opposite direction: 
1. Click that page to select it. The Page Order radio button must 

be selected for this. 

2. Select Rotate Page from the Imposition menu. This rotates the 
page by 90°. 

3. Select Rotate Page from the Imposition menu again. This 
rotates the page by 180°. 

The Imposition Setup Dialog 

To alter the type of an existing imposition, select Setup… from the 
Imposition menu. The Imposition Setup dialog appears: 
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You can change the Imposition Type and size of the imposition by 
choosing the required new values. You can retain the existing 
information about page numbers, orientation, page positions and 
trims by unchecking the relevant check boxes. 

The Page Positions Dialog 

It is possible to precisely position individual pages within a job, if 
you have special creep and bottle requirements not met by the 
standard features of the software.  

Select Page Positions… from the Imposition menu.  

The Page Positions dialog appears: 

 

Current Page 
Shows the page on which the adjustments will apply. You can 
move to other pages using the left and right arrows. 

Units 

The units that any offsets are measured in. 

Mirror Values for Front/Back Alignment 

If this is checked, any adjustments you make are automatically 
applied to the corresponding page that will be printed on the back 
of the finished sheet. 
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Horizontal Offset 
The horizontal distance that the page will be moved. 

Vertical Offset 
The vertical distance that the page will be moved. 

Rotation 
The angle that the page will be rotated. 

Apply To 

The radio button indicates which pages these adjustments are 
applied to. 

You can choose to apply them to: 

This Page -the current page  

This Row - the current row of pages 

This Column - the current column of pages 

This Block - all the pages on the current block 
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FLATWORK 
Flatwork allows you to place single pages on any sheet in any 
order, orientation, and scaling. This is useful to print custom 
layouts not possible with normal media saving or imposition 
printing. 

Note:  Imposition Publisher places pages, not separations. If you 
are working with colour separated files, then the 
appropriate separations will be generated for each colour. 

To Create A Flatwork 

1. Create a new File List and add files to it. 

2. Create a new Flatwork document (File menu, New 
Flatwork…). 

3. Add pages to the Flatwork: 

Either 

Drag pages from the File List onto the Flatwork window. To see all 
the pages in a file, click the small plus sign to the left of the 
filename. Select the pages you want and drag the pages over. 

Or 

Use the Add Items button in the Flatwork window. This opens the 
Add Items dialog that gives precise control in regularly spacing 
the pages on the sheet. Enter 20 mm, 20 mm for the Starting From, 
5 mm, 5 mm for the Space Between Items and 5 mm in Crop Margin 
boxes. The dialog should look like this: 
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Leave everything else as it is and click OK. Imposition Publisher 
places these pages on the flatwork sheets: 
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Saving a Flatwork 

A flatwork template can be saved for later use. To do this: 

1. Select Save from the File menu: 

2. Enter a file name and click Save 

Opening a Flatwork 

To open a Flatwork: 
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1.  Select Open… from the File menu and select the Flatwork you 
want to open.  

This will open the Flatwork window, as it was when it was last 
saved. 

You are now ready to print your Flatwork. See below for details 
on Printing, Device Setup and Print Marks. 

Note: A flatwork template is linked to the current file list. 
Because the flatwork contains the co–ordinates of each 
page, changing the file list or altering the order of pages 
may produce unexpected results. 

The Flatwork Window 

 

The Flatwork Window shows a to scale representation of your 
output sheet(s). Individual pages can be precisely positioned using 
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the mouse. Alternatively, they can be  regularly spaced 
automatically using the Add Items…dialog. 

Add Items… 

Adds pages from the current File List with control over page 
positioning and spacing.  

(See The Add Items Dialog section below.) 

Flow Items…  

Reflows (repositions) pages in the current Flatwork with control 
over page positioning and spacing.  

(See The Flow Items Dialog section below.) 

Sheet Size… 

Sets the sheet size for the Flatwork 

(See The Sheet Size Dialog section below.) 

Device Details 

Displays the current Flatwork sheet size and orientation. 

Flatwork Pages 

Pages added to the Flatwork can be positioned using the mouse or 
the Flatwork Palette. Pages can be manipulated individually or 
the same actions applied to several selected pages. 
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All pages are displayed with certain characteristic features: 

 

Selected pages are displayed with black dots in the page corners. 
Multiple pages can be selected by dragging the mouse over several 
pages or by shift clicking to extend the selection. Actions such as 
moving or resizing pages only apply to selected pages. 

A red dot denotes the corner used to snap to any guides. This is 
the corner the mouse is closest to. Pages will snap to the guides if 
Snap To Guides is turned on in the Flatwork menu. This allows 
you to snap any corner of a page to the guides, by dragging the 
page by a point close to that corner. 

(See Ruler Guides below.) 

A blue arrow denotes the orientation of the page. Cmd-click rotates 
the selected page in 90° clockwise intervals. Cmd-Shift-click rotates 
them in 90° anti-clockwise intervals. 

A file name indicates the file that the page belongs to from the File 
List. The file name and size of pages are dynamically updated in 
relation to the current File List. Any page number that is outside 
the range of the File List has no file name and will not print. 

Crop marks. You can turn crop marks on or off by clicking on the 
individual crop mark, highlighted in red, if certain crop marks are 
not required. Use the Option key to select all the crop marks for a 
page. Whilst the pages and their positions are displayed to scale, 
the crop marks are only representations (at present). The crop 
mark length is set in the Mark Option dialog within the Print 
Marks dialog. The spacing between the crop marks and the pages 
is set in the Trims & Bleeds panel in the Print Options dialog. 
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Crop marks are only displayed if Show Crop Marks in the 
Flatwork menu is turned on. 

Crop margins denoted by the white space around each page. All 
marks for that page will only print if they fit within the crop 
margins. 

Crop areas denoted by the grey outline as the boundaries of the 
crop margins. The Crop area will only be displayed if Show Crop 
Areas in the Flatwork menu is turned on. 

Enclosing rectangles denoted by the purple outline as the 
enclosing boundaries of the pages including the crop margins. 

Enclosing rectangles are only displayed if Show Enclosing 
Rectangles in the Flatwork menu is turned on. 

Rulers 

On each sheet there are two rulers to help in the positioning of 
pages. The markings on the rulers are displayed in the units set by 
the Information palette (see below). The top left corner of the 
scrolling window also displays the X, Y point of the mouse as you 
move around the Flatwork window. 

Rulers are only displayed if Show Rulers in the Flatwork menu is 
turned on. 

Ruler Guides 

Ruler guides define a grid over the flatwork sheet that can be used 
to position pages. The guides are represented by a T shape just 
above the horizontal ruler and to the left of the vertical ruler. 

Guides are only displayed if Show Guides in the Flatwork menu is 
turned on. 

Pages will snap to the guides only if Snap to Guides in the 
Flatwork menu is turned on. 

There are 2 kinds of guides - regular and custom.  
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Regular Guides  

Regular guides are denoted by a solid black pointer on the ruler. 
The distance of the regular guide from the origin of the ruler 
determines the spacing of a repeating pattern of guidelines. 
Regular guidelines are drawn as closely spaced dotted lines, an 
almost solid line.  

The guide can be dragged to change the spacing of the lines. To 
have no regular guides, drag the guide to the origin of the ruler. 

Option-click in a ruler to move the regular guides to the mouse 
point. The guide snaps to the nearest ruler interval. 

Cmd-Option-click in a ruler to move the regular guides to the mouse 
point. The guide does not snap to the nearest ruler interval. 

Custom Guides  

Custom guides are denoted by a hollow pointer on the rulers. 
They are created by clicking the mouse on the ruler where you 
want the guide to be. These guides can be dragged around to 
change their position or can be removed by dragging them off the 
ruler. Custom guidelines are drawn as normal dotted lines. You 
can have as many as you wish on each axis. 

When dragging guides they always snap to the nearest ruler 
interval by default. 

Click in a ruler to add a custom guide that snaps to the nearest ruler 
interval. 

Cmd-click in a ruler to add a custom guide that does not snap to the 
nearest ruler interval. 
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Sheet Index Menu and View Options Menu 

The Sheet Index and View Options menus are positioned at the 
bottom left of the Flatwork window. 

 

The Sheet Index menu displays how many sheets are in the 
Flatwork and which is the current one. You can select a sheet from 
the popup menu to make it the current sheet displayed in the 
Flatwork window.  

The View Options menu displays the current magnification. Select 
from the popup menu to change the magnification, within the 
range 1 to 800%. 

Option-click the sheet to reduce the magnification. 

Shift-Option-click the sheet to increase the magnification. 

Ctrl 0 (zero) scales the flatwork to fit in the current window. 

The Flatwork Palette 

The Flatwork Information palette can be used to manipulate 
pages on a sheet. You can replace, move, rotate and scale pages, as 
well as adjust the crop margins and lock pages to the sheet 

Select Show Palette from the Window menu. If the palette is 
already visible this menu item will appear as Hide Palette.  
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The Flatwork palette appears: 

 

Units  

Changes the palette and the Flatwork ruler units. 

Items Selected  

Displays the number of pages that are selected.  

Locked Check Box  

Locks and unlocks selected page(s). Locked pages cannot be 
moved or altered in any way. This is useful if you do not wish to 
disturb pages once they are in position. 

File  

The file in the File List that the page(s) belongs to.  

Page Number ( )  

The page number in the File List of the selected page. The page 
can be changed to another page from the File List by entering the 
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required page number. If multiple pages are selected, this field 
displays —. 

Page Position (X and Y)  

Moves selected page(s). The position is displayed relative to the 
Flatwork sheet origin (top left corner). If multiple pages are 
selected, these fields display —. 

Page Size (W and H)  

The size (Width and Height) of the selected page(s). 

Rotation ( )  

Rotates the selected page(s) clockwise by the entered angle. 

Scaling ( )  

Scales the selected page(s) by the entered percentage. 

Crop Margin (T, B, L and R)  

Sets the crop margins for selected page(s), i.e. the clipping margins 
around each page. Nothing will print outside those margins. 

Adding New Sheets To A Flatwork 

You can add and remove additional sheets to a Flatwork using the 
Flatwork menu. The new sheets can be blank, be an exact copy or 
be a mirror image of another sheet. 

 

New Blank Sheet  

Select New Sheet to add an empty sheet to the current Flatwork. 
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Duplicate Sheet  

Duplicate the positions and alignments of pages on the current 
sheet and add it to the current Flatwork.  

The sub-menu gives the option of duplicating the sheet in two 
ways: 

A Normal duplicate is a straight copy of the current sheet 

A Mirror duplicate is a new sheet that mirrors all page positions 
on the current sheet for Front/Back alignment. 

Delete Sheet  

Select Delete Sheet to deletes the currently selected sheet.  

The Add Items Dialog 

 

The Add Items Dialog places pages from the File List onto the 
Flatwork sheet. 
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Pages  

Adds all pages or a range of pages from the current File List 

Copies 

Adds multiple copies of the page(s) 

Units 

Switches units locally within this dialog. 

Left To Right 

Adds the pages Left To Right across the sheet. Pages will then 
automatically wrap onto the next row until all pages have been 
added. 

Top To Bottom 

Adds the pages Top To Bottom down the sheet. Pages will then 
automatically wrap onto the next column until all pages have been 
added. 

Create Sheets if Needed 

New sheets will automatically be created when the current sheet 
filled and all the pages have not yet been added. 

Wrap Every “N” Pages 

Allows you to control how many pages are placed in a row (or 
column) before Imposition Publisher moves on to or wraps on to 
the next row (or column). If this is off then Imposition Publisher 
wraps automatically after it reaches the other side of the sheet. 
You can use this to step and repeat pages on a Flatwork sheet. 

For example, to place 4 copies of page 1 in a column on the left 
and 4 copies of page 2 in a column on the right then set Pages From 
1 to 2, Copies to 4, Top to Bottom on and Wrap Every 4 Pages. 

Starting From  

The position of the first page. All subsequent pages are positioned 
relative to this starting point. 
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Note: The origin in Flatwork is always the top left corner of a 
sheet. 

Space Between Items 

The spacing between the pages. This is in addition to the spacing 
allocated for each page in the crop margin fields. 

Crop Margin  

Sets the clipping margins around each page. Any print mark  
outside these margins will not print. 

Note: page & block print marks  apply to each page and NOT the 
sheet. To add sheet marks to a Flatwork, save your print marks 
with offsets from start of sheet. 

Rotation 

Applies a rotation to all pages that are added. 

Scaling  

Scale all pages that are added. 

The Flow Items Dialog  

 

The Flow Items dialog re-flows or replaces any selected pages on 
the sheet, creating new sheets if necessary. 
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Units 

Switches units locally within this dialog. 

Left to Right 

Re-flow the selected pages from Left to Right across the sheet. 
Pages will automatically wrap onto the next row until all pages 
have been re-flowed. 

Top to Bottom 

Re-flow the selected pages from Top To Bottom down the sheet. 
Pages will automatically wrap onto the next column until all pages 
have been re-flowed. 

Create Sheets if Needed 

If this is checked on, new sheets will automatically be created 
when the end of a sheet is reached and all the pages have not yet 
been re-flowed. 

Wrap Every “N” Pages 

Allows you to control how many pages are placed in a row (or 
column) before Imposition Publisher moves on to or wraps on to 
the next row (or column). If this is off then Imposition Publisher 
wraps automatically after it reaches the other side of the sheet. 
You can use this to step and repeat pages on a Flatwork sheet. 

For example, to place 4 copies of page 1 in a column on the left 
and 4 copies of page 2 in a column on the right then set Pages From 
1 to 2, Copies to 4, Top to Bottom on and Wrap Every 4 Pages. 

Starting From  

The position of the first page. All subsequent pages are re-flowed 
from there.  

Note: The origin in Flatwork is always the Top Left corner of a 
sheet. 

Space Between Items 

The regular spacing between the selected pages. This is in addition 
to the spacing allocated for each page in the crop margin fields. 
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The Sheet Size Dialog 

 

Sets the sheet size for the Flatwork. Usually this will be the same 
size as your output device. 

Paper  

 

A pop-up menu allows you to set up a Flatwork sheet size from a 
list of standard paper sizes. 

Units  

Switches units locally within the dialog. 

Width  

Sets the Flatwork sheet width in the currently selected units. 

Height  

Sets the Flatwork sheet height in the currently selected units. 
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Use Device Size  

Sets the Flatwork sheet size to the same as the current output 
device setting. 

Orientation icon  

Toggles between portrait and landscape orientation. 

The Guide Lines Dialog 

Select Guide Lines… from the Flatwork menu or double-click the 
sheet background to bring up the Guide Lines dialog. This dialog 
controls regular and custom guides for the current Flatwork to 
allow you to position pages precisely. 

Note: For pages to snap to the guides, the Snap To Guides option 
of the Flatwork menu must be turned on. 

 

Units  

Switches the units locally within this dialog. 
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Horizontal Spacing 

Sets regular horizontal guides. The value controls the spacing 
between guides. 

Also:  
Allows you to create a list of non-regular or custom horizontal 
guides by adding (Add) and removing (Remove) from the list. 

Vertical Spacing 

Sets regular vertical guides. The value controls the spacing 
between guides. 

Also: 
Allows you to create a list of non-regular or custom vertical guides 
by adding (Add) and removing (Remove) from the list. 

Save Settings  

Saves the settings as defaults so that all new Flatwork documents 
will be created with this set of guides. 

Flatwork Shortcuts 

Copy (Ctrl C) 

Copies the selected pages or sheets to the Clipboard. This 
information can then be pasted into the same or another Flatwork 
document. 

Cut (Ctrl X)  

Cuts selected pages sheets from the current Flatwork to the 
Clipboard. 

Paste (Ctrl V)  

Pastes pages or sheets from the Clipboard into the current 
Flatwork document. 

Scale to Fit (Ctrl 0 (zero) ) 

Scales the flatwork sheet to fit in the current window. 



User Guide Chapter 2 

70 

Reduce Magnification (Option Click the sheet) 

Reduces the Flatwork view magnification. 

Increase Magnification (Shift Option Click the sheet) 

Increases the Flatwork view magnification. 

Toggle Snap To Guides (Ctrl Y)  

Turns on (or off) the Snap To Guides option. 

Rotate Page (Ctrl Click a selection of pages)  

Rotates page(s) in 90° clockwise intervals. 

Rotate Page (Ctrl Shift Click a selection of pages)  

Rotates page(s) in 90° anti-clockwise intervals. 

Add Custom Guide (Ctrl Click a ruler)  

Adds a custom guide that does not snap to the nearest ruler 
interval. 

Move and Snap Guide to Mouse (Option Click a ruler)  

Moves the regular guide to the mouse point. The guide snaps to 
the nearest ruler interval. 

Move Guide to Mouse (Ctrl Option Click a ruler) 

Moves the regular guide to the mouse point. The guide does not 
snap to the nearest ruler interval. 

Guide Line Dialog (Double Click the sheet) 

Brings up the Guide Lines dialog 

Turn Crop Marks On/Off (Option Click in the crop area) 

Toggles on or off all the crop marks (highlighted in red) for the 
selected pages. 
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PRINT MARKS 
You can easily create your own sets of print marks to use with 
particular jobs. You can also create special or custom print marks 
from EPS and PDF files. The print mark sets are saved so they are 
available every time the program is used.  

This section is divided into the following parts: 

• The Print Marks Dialog 

• Standard Print Marks 

• Custom Print Marks 

The Print Marks Dialog 
Selecting Print Marks… in the Edit menu or clicking the Mark 
Set: Edit button in the Print dialog displays the Print Marks 
dialog: 

 

This dialog is used to specify which print marks to use. The list of 
checkboxes shows the standard print marks and any custom print 
marks you may have created.  



User Guide Chapter 2 

72 

Any combination of marks can be saved as a Mark Set for future 
use. All mark sets are accessible from the Mark Set popup. Any 
required mark set can be chosen from the Print dialog at the time 
of printing.  

Click the checkboxes in the left-hand list and the marks will 
appear in the preview display on the right hand side. 

• The first twelve checkboxes are Imposition Publisher’s 
standard print marks. Marks can be switched on and off by 
using the checkboxes, or deleted from the list by selecting Cut 
from the Edit menu. The parameters for each mark can be 
edited by selecting the mark and clicking the Edit button. 

• Some print marks are not applicable for all types of print jobs. 
For example, if Media Saving is selected, then Centre Guides 
and Centre Crosses are not applicable and are disabled. 

• Custom print marks also appear in the list of print marks. 
They can be switched on and off, moved and edited in the 
same way as the standard print marks. 

• The order that marks print is determined by their order in the 
list. This can be important if 2 marks occupy the same space. A 
mark that is further down the list will be output after (on top 
of) a mark higher in the list. 

OK (or Save)  
Exits the Print Marks dialog. This button will change to Save if the 
current print mark set has been changed. 

Save As… 
Save the current set to a differently named print mark set.  

Delete 
Delete the current print mark set. 

New… 
Opens the Edit Mark dialog with settings for a new Custom Mark. 

Edit… 
Opens the Edit Mark dialog for the selected mark. 
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Editing Print Marks 

1. In the Print Marks dialog select the mark in the list and click 
Edit…. Or double-click the mark name.  

The Edit Mark dialog appears 

2. Make the changes required in the dialog. 

3. Save the mark. 

In every Edit Mark dialog there are 2 buttons at the bottom left 
hand corner – Use Defaults and Save As Defaults. 

Save As Defaults 
Saves the settings for the current type of print mark to the 
preferences file. Any new mark of this type will inherit these 
settings. 

Use Defaults 
Restores the settings for the current print mark to the default 
values for that type of print mark. 

Copying Print Marks 

1. Select the mark in the print mark list. 

2. Click Copy. 

3. Supply a new name for the duplicate mark 

Deleting Print Marks 

1. Select the mark you want to delete in the print mark list. 

2. Click the Delete key to delete the mark from the list. 
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Standard Print Marks 

Crop Marks 

These are marks that appear around the edge of the block 
indicating the edges of the individual pages. 

  

The length of the Crop Marks is shown in the Mark Length field. 

If Calculate Length Automatically is checked, Imposition 
Publisher will adjust the length of the crop marks according to the 
free space available.  

Sometimes a job will only just fit on an output device, leaving very 
little room for crop marks. Rather than having to repeatedly 
change the length of crop marks for different jobs, you can check 
the Calculate Length Automatically option, which allows 
Imposition Publisher to vary the length of the crop marks. The 
Preferred Length will be used where possible, the length will be 
reduced down to the Minimum Length, if necessary. 

Centre Guides 

These are marks that appear around the edge of the block marking 
the centre line between rows and between columns of pages. 

Centre Crosses 

These are crosses that mark the centre of a group of four pages. 
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Page Outline 

Pages will print with a dotted outline. These can be used in place 
of Crop Marks, usually for imposition proofing. 

Collating Marks 

A collating mark is a small rectangle that appears on the outside 
spine of each section. If a job contains multiple sections the 
collating mark is a useful visual aid that all sections are present 
and in the correct order. The collating marks areeasily visible 
when the different sections are collated together for finishing. 

Imposition Publisher automatically calculates the positions of the 
collating marks. They start at the top of the spine and work down. 
The length and width of the collating mark and its starting offset 
along the spine can be set in the Collating Mark dialog: 
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Signature Marks 

This is a text label that prints on each block. It shows the section 
letter and whether it is an outer or an inner block. The section 
letter is also printed at the foot of the first page of the section. 

 

Start At Signature # 

This is used to specify the location of the first section being 
imposed. If the current print job was the fourth section, this field 
should be set to D.  

The position of the signature label can be changed by using the 
Horizontal and Vertical Offsets. 

The Signature Marks (indicating the first page of a section) and 
the Signature Labels (to specify the block letter) can be 
independently turned on and off. When a job is tiled the Signature 
Label will be printed on all tile pieces if the checkbox print On All 
Tile Pieces is checked.  
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User Label  

This is a text label that will print on  each block. There are a 
number of special options which insert information automatically. 

 

Font 

Specifies the font and size that the label text is printed in. The 
choices are: 

 

Position 

Specifies where on the block the label prints. The following choices 
are available: 

 

The Section Spine is the gutter between the first and last pages of 
each section i.e. the spine. 
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Note: If the User Label check box is switched on an icon 
representing the user label will be displayed in the print 
marks preview at the corresponding position. 

Units 

The offsets are measured in units set in the Units popup. 

Offsets From 

This specifies whether to measure the offsets from the edge of the 
Page or from the edge of the Trim area or the edge of the Sheet. 

 

Offsets In From Corners, Offsets Away From Edges 

These offsets can be used to position the user label anywhere on 
the block. The offsets are measured from the selected position 
above. 

On All Tile Pieces 

If checked on, the user label will be printed on all tile pieces, if the 
imposition has to be tiled. 

Facing Inwards 

If checked on, the text of the user label will be printed so that the 
base of the text is closer to the pages than the top of the text. 

Label Icons 

Imposition Name  
This will place a marker in the label that will be replaced by the 
imposition name when printing.  

Flatwork Name 
This will place a marker in the label that will be replaced by the 
flatwork name when printing.  

Date & Time  
This will place a marker in the label that will be replaced by the 
date and time of the job when printing. 
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Plate Colour  
This will place a marker in the label that will be replaced by the 
plate colour of the current block being printed. 

Block #  
This will place a marker in the label that will be replaced by the 
block number of the current block being printed. 

Signature(s) #  
This will place a marker in the label that will be replaced by the 
signature letter or number of the current block being printed. 

Document Job Title  
This will place a marker in the label that will be replaced by the 
Job Title from the current PostScript file being printed. NB This 
feature is not applicable to all types of PostScript files. 

Document User  
This will place a marker in the label that will be replaced by the 
user name comment from the current PostScript file being printed. 
NB This feature is not applicable to all types of PostScript files. 

Document Page #  
This will place a marker in the label that will be replaced by the 
page number of the current page being printed. This is applicable 
to media saving printing where every page can have its own label. 

Print Job Name 
This will place a marker in the label that will be replaced by the 
job name entered in Imposition Publisher Print dialog. 

When you have finished setting up the User Label, click Save to 
return to the Print Marks dialog. 
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Colour Bar 

This is the Imposition Publisher standard colour bar. It will print 
along the length or width of each block and will colour-separate if 
necessary. It can print up to 6 colours in one bar. If you use more 
than 6 colours in a job, an extra colour bar will be printed outside 
the first one.  

  

Select which position you require from the following: 

   

Offset Away From Edges  

This is the distance to the start of the colour bar from the edge 
selected in the Position and Offset pop up menus. 

Bar Width 

This controls the height of the colour bar squares. 

Registration Marks 

Registration marks print in the same place on each colour 
separation. They are used to check that different colours are 
correctly aligned – that they are in register.  
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The Registration Marks dialog is used to select different options. 
You can choose between standard registration and CPC 4 marks 
from the Type: pop up menu.  

There are several different positioning options. The offsets are the 
distance to the centre of the registration mark, measured from the 
location specified by the Positions and Offset pop up menus. 

 

Size 

This specifies the diameter of the standard registration mark. 

CPC 4 Marks 

These are Heidelberg CPC 4 marks. CPC 4 marks can be used in 
place of standard registration marks and positioned in a similar 
way to the standard registration mark. The size of the CPC 4 
marks cannot be altered as many optical readers rely on its fixed 
geometry. 
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Grip Mark 

The grip mark, also known as a side guide mark, is used to 
identify the leading edge of the plate or paper, for ease of 
handling. Select the position you require from the Position menu. 

 

Offsets 

These are the values used to position the mark from its position 
selected in the Position menu. 

Tiling Mark 

Tiling marks are used to align the tiles pieces after printing. It also 
helps you to identify  individual tile pieces.  
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Custom Print Marks 

If your print mark requirements are not met with the standard 
print marks, you can create custom print marks using any EPS file. 
Custom print marks are added to the list of checkboxes in the Print 
Marks dialog. 

Custom print marks can be checked on or off as needed in the 
Print Marks dialog. When switched on, the custom marks will 
appear in the right hand preview display, roughly to scale, in the 
correct position and size relative to the page.  

Creating a New Custom Print Mark  

This section explains how to set up a custom mark. Custom marks 
are special print marks based on EPS or PDF files. 

1. Select Print Marks… from the Edit menu. 

2. Select New… from the Print Marks dialog.  

This opens the Custom Mark dialog where you can set up the new 
custom mark. 

 

In the Custom Mark dialog, you must: 

3. Click Select Mark… to choose an EPS or PDF file. 

4. Select a Position from the Positions popup. 
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5. Enter any other options you may want. Other options 
available are: 

• Scaling: the mark scaling (between 1% & 1000%). 

• Orientation: the orientation (0°, 90°, 180°, 270°). 

• Hot Spot: a point on the EPS that lines up with the 
selected position. 

• Offsets: relative to the selected position. 

• Print On: which blocks/signatures to print the mark on. 

Custom Mark Options 

Units 

The units in which to display the custom mark offsets and the 
dimensions of the EPS file. 

File 

This is the name of the EPS or PDF file to be associated with the 
mark. Once the file has been selected, the name and size in 
kilobytes are displayed here. 

Note: Any file used for a custom mark must be put inside the 
Marks folder (or folder nested inside the Marks folder). 

Size 

Once a file has been selected, the dimensions and file size are 
displayed here. 

Scaling 

This allows scaling up or down of the mark. Choose values 
between 1% and 1000%. If the mark is re-scaled the preview 
display will show this. 

Orientation 

This allows the mark to be rotated to the correct orientation. 
Choose between 0°, 90°, 180° and 270°: 
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If the mark is re-orientated then the preview will show this. 

Hot Spot 

The hot spot is the point in the mark that is chosen to line up 
exactly with the selected position(s). Use this in conjunction with 
the position and offsets to place the custom mark. The default hot 
spot is Centre but there are several other choices: 

  

Preview  

Switches the preview image on or off. If the preview takes too long 
to display, then switch previewing off. 

Positions 

There are thirteen possible positions for each custom mark. 

Custom Mark Examples 

1. To print a colour bar centred along the top, select the top 
middle position together with the centre hot-spot selection. 

2. To print a colour bar left aligned along the top, select the top 
left position together with the left edge hot-spot selection. 

3. To print a rotated colour bar vertically and top-aligned down 
the left side, select the top left position together with the top edge 
hot-spot selection. 

4. To print a rotated colour bar vertically and bottom-aligned up 
the right side, select the bottom right position together with the 
bottom edge hot-spot selection. 
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Offset 

Allows you to decide whether the offsets should start from the 
edge of the page or the edge of the trim or the edge of the sheet 
area. 

 

Offsets 

These are the horizontal (X) and vertical (Y) offsets that can be 
used to position the mark anywhere on the block. The offsets are 
measured from the selected position(s) above. 

Print On 

This selects which blocks the custom mark will print on. For some 
marks you may wish to print them on all blocks, but for other 
marks only print on some blocks or at certain regular intervals. 
The following choices are available: 

  

All Blocks 
Print the custom mark on all blocks. 

Even Blocks 
Print the custom mark on all even blocks. 

Odd Blocks 
Print the custom mark on all odd blocks. 

Section Outers 
Print the custom mark on all blocks that are section outers i.e. the 
block containing the outside pair of pages, the first and last pages 
of each section. 
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Section Inners 
Print the custom mark on all blocks that are section inners i.e. all 
blocks not containing the outside pair of pages, the first and last 
pages of each section. 

Selected Blocks 
Print the custom mark only on the specified blocks. 

 

You can use any punctuation character as a delimiter. 

Saving Custom Marks  

Click Save to save the custom mark. If it is a new mark you will be 
prompted to enter a name for the mark.  
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Once saved the new custom mark will appear in the Print Marks 
dialog as a checkbox in the list: 

 

To use this custom mark simply check it on. It will then appear in 
the display at the position selected. 

Preview  
If this is checked, then a preview image of each custom mark will 
be displayed (if available) If this is not checked, then any custom 
marks will be displayed using a generic image. This can be useful 
if custom marks based on complex files take a long time to render. 

Disabled Custom Marks 
If Imposition Publisher cannot locate the file associated with the 
custom mark, then the mark name appears in red. To enable it, 
either: 

• Click the check box to search for the file. 

• Double-click the custom mark to search for the file and edit 
the custom mark. 
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Points to remember 

• To save a custom mark, you must select an EPS or PDF file.  
• For each custom mark be aware of: 

i. Which position has been selected 

ii. What offsets are set 

iii. Which hot spot has been selected. This could dramatically 
change the position of the custom mark on the block. 

iv. The orientation of the custom mark 

v. The scaling of the custom mark. 

Print Marks Shortcuts 

This is a summary of the Print Mark options. 

Print Marks… (Ctrl M) 

Use this to open the Print Marks dialog. 

New Mark… (Alt N) 

Click New Mark… to create a new print mark. 

Edit Mark… 

Click Edit… to edit the selected  mark. 

Copy (Alt C) 

Click Copy… to copy the selected mark. 

Remove (Delete key) 

Remove the selected mark from the list. 
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DEVICE SETUP 
This section is about setting up printer device settings for trouble 
free printing. The default settings should work just fine once you 
have specified the dimensions of your output sheet. There is 
support within Imposition Publisher for aligning the output onto 
the sheet exactly as required, even when using punch control 
systems. 

This section is divided into the following parts: 

• Creating, Saving and Deleting Print Devices 

• Printing to Imagesetters 

• The Page Setup Dialog 

Creating, Saving and Deleting Print Devices 

A print device file contains information about your output device 
settings and job alignment. Print devices can be created for any 
output devices and for any jobs requiring specific alignment or 
orientation settings.  

Imposition Publisher displays previously saved devices in a 
popup menu in the Print dialog. The device settings can easily be 
changed up to the moment of printing. When you click Save As… 
in the Device Setup dialog and enter a new name, a new print 
device file is created. You can have any number of devices 
according to your own needs. 

Device files are stored in the Devices folder inside the Imposition 
Publisher installation folder. If no device files are found, a default 
device is created from information in the Preferences file. 
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Creating a Print Devices 

1. Select Page Setup… from the File menu. The Page Setup 
dialog appears: 

 

2. Enter the desired values for the new device. See The Device 
Setup Dialog below for more details. 

 

3. Click Save As… to save these values and create a new print 
device: 

4.  Type in the new name and click Save: 



User Guide Chapter 2 

92 

 

The new device should now appear in the Device popup as the 
current device 

Deleting Print Devices 

1. Select Page Setup… from the File menu. 

2. Select the device in the Device popup. 

3. Click Delete 

4. Confirm deletion of the device by clicking Yes. 

 

Warning If there is only one device it cannot be deleted. 

Note 

As print devices are files in the Devices folder it is also possible to 
copy and delete them using the Windows Explorer. 
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Printing to Imagesetters 

Continuous Output Devices 

 

A Continuous output device is any roll-fed device that allows 
different sheet depths. Imposition Publisher will automatically 
calculate the depth needed for that job and sets up the imagesetter 
accordingly. In this mode whole blocks, or tiled sections, will be 
printed in one go.  

There is a Max. Depth value which, if not set to zero, will be used 
as the maximum depth of a continuous device. If a block or flat 
exceeds this depth then Imposition Publisher will tile the output. If 
this is set to zero, entire blocks are printed in one go.  

Important Points to Remember 

1. When printing to a continuous machine, the width should be 
set to the image width, which is not necessarily the width of 
the material.  

 For example, an imagesetter running 12" (304.8 mm) material, 
the image width is typically 303 or 304.8 mm. A rangecheck 
error from your RIP is an indication that the value for Media 
Width is set too large in the Device Setup dialog. 
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2. When printing with crop marks, Media Saving works out the 
most efficient way to print the pages, given the crop mark 
length in the current print mark set and the Edge Trim values 
in the Trims & Bleeds panel of the Print Options dialog.  

 For example, if the material width is 304.8 mm, the page size is 
A4 (210 mm x 297 mm), the Mark Length is set to 2 mm, and 
crop marks are required, Media Saving will print the pages 
sideways with 2 mm crop marks spaced 1.9 mm away from 
the edges of the page. For smaller page sizes or wider material 
this routine will print several pages across. 

The Page Setup Dialog 
Selecting Page Setup… from the File menu brings up the Page 
Setup dialog: 

 

Device 

This popup allows you to select the device that you wish to edit or 
print to. 
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Paper 

This popup allows you to select the device dimensions. 

 

Units 

This popup allows you to select which units to display for the 
device dimensions and offsets. 

Media Width 

This is the printable width of the media (film, plate or paper), 
which may not be the same as the physical width. 

See Printing to Imagesetters for details on setting up continuous 
devices. 

Media Height/Max. Depth 

Media Height 
This is the printable height of the media. This is available unless 
the Paper is set to Continuous. 

Max. Depth 
For Continuous devices this value will be used as the maximum 
depth. If a block or flat exceeds this depth Imposition Publisher 
will tile the output. If the value is set to zero, then whole blocks 
are printed in one go. 

Printer Offsets 

When printing in duplex mode on a laser printer or proofer, 
frequently, the pages print slightly off in alignment, front and 
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back. The printer’s image area can be moved using these offsets. 
The offsets are measured from the bottom left corner. 

For example, if printing an A5 booklet on an A4 or US Letter size 
printer, you can use these offsets to ensure that the pages print 
centrally. This means that the pages line up exactly on the front 
and back when printing in duplex mode. 

Left Offset 
This will move the image area right on the paper by the specified 
distance. To move it left a negative value can be entered. 

Bottom Offset 
This will move the image area up by the specified distance. To 
move it down, enter a negative value. Not applicable to 
continuous devices. 

Block Spacing 

The space to be left between blocks, when it is possible to place 
multiple blocks on an output sheet. 

For example, if it is possible to fit several blocks onto one sheet, 
then enough space needs to be left between the blocks so that the 
print marks do not overlap. 

Save   

Save the current settings to the currently selected print device. 

Save As 

Save the current settings to a new device.  

Delete 

Delete the currently selected print device. 

Alignment 

The second part of the Device Setup dialog allows you to specify 
exactly how the output should be positioned on the device area. 
Click the Alignment tab to access the Alignment pane: 
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This part of the dialog allows you to accurately place impositions 
on the device area. 

To switch back to the main Device Setup dialog click the 
Dimensions tab. 

Tiling Format 

There are several choices available from the Tiling Format popup: 

 

No Tiling 
Print whole blocks only, i.e. no tiling will occur. The display 
shows a single block and its position on the output sheet. Offsets 
and orientation settings will apply to all blocks printed using this 
setting. 

Automatic Tiling 
Automatically tile the output. The display still shows a single 
block - it is not yet known whether tiling is necessary or in which 
orientation the blocks or tile pieces will print. However, 
Imposition Publisher will automatically calculate the best tiling 



User Guide Chapter 2 

98 

pattern - so as to produce the fewest tile pieces, taking up the least 
amount of film. This is the default setting which is adequate for 
most situations. Offsets and orientation settings will apply to all 
blocks printed using this setting. 

No Tiling (Odd & Even)  
You can specify alignment and orientation values for all the odd 
numbered blocks and different values for all the even numbered 
blocks.  

Offsets and orientation settings apply to the blocks indicated in 
Settings for panel. The diagram below shows settings for the odd 
numbered blocks. To specify settings for even numbered blocks, 
select Even Blocks from the Settings for: popup. 

 

2 Tile Pieces (SS) 
Print each block in 2 equal tile pieces side by side, i.e. the block is 
split vertically. The display on the right will show the 2 tile pieces 
and their positions. 

Offsets and orientation settings apply to the tile pieces indicated in 
the title of the Position for: panel. The diagram below shows 
settings for the Tile piece 1. To specify settings for Tile 2, select 
Tile 2 in the Position for: popup. 
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2 Tile Pieces (HH) 
Print each block in 2 equal tile pieces, with the block split 
horizontally. The display on the right will show the 2 tile pieces 
and their positions. 

Offsets and orientation settings apply to the tile pieces indicated in 
the title of the Position for panel. The diagram below shows 
settings for the Tile piece 1. To specify settings for Tile 2, select 
Tile 2 in the Position for: popup. 
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4 Tile Pieces 
Print each block in 4 equal tile pieces. The display on the right will 
show the 4 tile pieces and their positions. 

Offsets and orientation settings apply to the tile pieces indicated in 
the title of the Position for box. The diagram below shows settings 
for the Tile piece 1. To specify settings for any other tile, click the 
image of that tile. The box title will change to the appropriate tile. 

 

Punch Control 

Imposition Publisher has been designed to work with any punch 
control system. 

Punch Holes 

Choices for the position of punch holes: 
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For example, if you have a job that will tile into 4 tile pieces and 
you select punch holes On Top, the individual tile pieces will be 
positioned as shown: 

 

Offsets From 

You can allow Imposition Publisher to position your output 
automatically to make the most use of your output device. If 
possible, multiple blocks will be placed on each sheet.  

Precise control is available by specifying offsets from the edge of 
your device’s imaging area to either the edge of finished page or to 
outside edge of the block. You should also set the horizontal or 
vertical alignment to align the block to the desired edge. 

 

Start of Page 
Any offsets are measured from the device edge to the edge of the 
pages in the block. This is represented in the display by the thick 
red line inside the trim area. 
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Start of Trims  
Any offsets are measured from the device edge to the outside edge 
of the crop marks. This is represented in the display by the thick 
red line around the entire block. 

  

Offsets 

The settings in the Offsets box control the orientation and position 
of the block or individual tile pieces. This works in conjunction 
with the setting of the Tiling Format popup.  

If No Tiling or Automatic is selected in the Tiling Format popup, 
then the orientation and offset settings apply to all blocks or tile 
pieces. 

If Odd & Even Blocks is selected in the Format popup, then the 
settings apply to either all the odd numbered blocks or the even 
numbered blocks, depending on the currently selected block. To 
select the other block click its image on the preview display. 

If 2 or 4 Tile Pieces are selected in the Format popup, then the 
settings apply only to the currently selected tile piece. To select 
other tile pieces click their image on the preview display. 

Orientation  
Sets the orientation of the block or tile piece: 

 

Important: If you require the output to have a specific orientation, 
for example for Direct to Plate work or for a Punch 
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system, you should set the orientation manually and 
not use the Automatic setting. 

The orientation of a block or individual tile piece can also be 
changed, in 90° increments, by clicking on the block or tile piece in 
the Alignment preview. 

Horizontal 
Sets the horizontal alignment for the block or tile piece. You can 
set an edge, Left or Right, or Centred, to align to and to measure 
offsets from: 

 

Positive offsets will shift the block or tile piece to the right and 
negative offsets will shift it to the left. 

Vertical 
Sets the vertical alignment for the block or tile piece. You can set 
an edge, Top or Bottom, or Centred, to align to and to measure 
offsets from: 

 

Positive offsets will shift the block or tile piece upwards and 
negative offsets will shift it downwards.  

Note: Vertical alignment is not available if using a continuous 
device. 

Reset This Block 
Will reset the orientation and alignment options for the selected 
block to their default values. 

Reset All Blocks 
Will reset the orientation and alignment options for all blocks to 
their default values. 
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Reset This Tile 
Will reset the orientation and alignment options for the currently 
selected tile piece to their default values. 

Reset All Tiles 
Will reset the orientation and alignment options for all tile pieces 
to their default values. 

The Alignment Preview 

The display on the right is a representation of the output device 
and the block or tile pieces.  

For example, in normal use: 

  

Or when 4 tile pieces and punch control is selected: 

  

• The device is the background (blue) frame. The block or tile 
pieces are clearly labelled.  
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• The device and the block or tile pieces are NOT drawn to 
scale. 

• The alignment offsets are drawn to scale relative to the 
device size. 

• The Device Leading Edge arrows (pink) indicate the direction 
of movement of film through the device and hence which edge 
of the block will appear first from the machine. 

• The thick red line indicates where the offsets are measured to, 
from the edge of the device. 

• The orientation of the block or tile piece can be changed in 90° 
intervals by clicking on the image of the block or tile piece. 

• To switch between different tile pieces just click the relevant 
one. The first click will switch to that tile piece and subsequent 
clicks will change the orientation as described above. 
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PRINTING AND PREVIEWING 
Imposition Publisher has a powerful and flexible Print dialog. All 
the options that you need are accessible from the Print dialog. You 
can change the device setup or change print marks simply by 
selecting from a popup list. 

This section is divided into the following parts: 

• The Print Dialog 

• The Options Dialog 

• The Progress Monitor 

• Previewing 

• Media Saving 

• Facing Pages Printing 

Note:  

• Most the options in printing are saved on a per-session basis 
i.e. they are reset each time you start Imposition Publisher. 

• Copies, Pages To & From and Blocks To & From are reset for 
each job. 
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The Print Dialog 

  

Printer 

This popup allows you to select a printer from the list of Windows 
printers available to your computer. When you click Print, the 
imposed file will be sent to the selected printer. 

Device 

This popup is used to choose device settings. All items that appear 
in the list are the saved settings stored in the Devices folder. 

  

If settings need changing click the Edit… button: 
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Edit… (Device) 

Allows you to edit an existing print device. See the section Device 
Setup & Alignment on how to create & edit device settings. 

Print To FIle 

This checkbox allows you to print the imposed job into a file, 
rather than directly to a printer. When this is checked, the Print 
button changes to Save. After clicking Save, you will be prompted 
to select a location to save the file and enter a file name. Any text 
entered in the Name field will be suggested as the file name. 

Preview 

Allows you to preview a job on screen before sending it to the 
printer. For PostScript jobs you need Adobe Acrobat Distiller 
installed. For PDF jobs you just need a PDF viewing program, like 
Adobe Reader. 

Marks Only allows you to preview the layout of a job. In this case 
all selected marks appear. But the page contents are replaced by 
placeholders showing the file name, the page number and the 
separation colour name. 

Print To PDF 

Imposition Publisher will create a PDF file as its output. NB For 
PostScript jobs this requires Acrobat Distiller. 

Job Type 

This popup shows the type of print job and the template in use. 
The popup can be used to switch between any open imposition 
and flatwork template or between Media Saving, Step & Repeat 
and Facing Pages job types. 

 

Name 

The text entered in this field is used as the Job Name in the 
imposed file. The job name may appear on certain Rips or printer 
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management systems. The job name is also used as the file name 
for the imposed file, making it easy to keep track of different jobs. 

Copies 

This is used to select how many copies of each block to print. The 
default is 1. The maximum is 1000. 

Saddle Section Size 

This is available for Saddle Stitched Imposition only, and refers 
to the number of pages per section. For example, for a standard 
saddle stitch with 32 page sections, you would enter 32 for the 
Section Size. Then page 1 prints with page 32, page 2 prints with 
page 31 and so on. 

Pages 

This is used to select which pages to print. The default is All 
pages. Use To and From fields to select a Range of pages: 

  

From 
Select the first page to print. The default is 1. If this value is zero or 
empty, Imposition Publisher will use the default value. 

To 
Select the last page to print. The default is the number of pages in 
the File List. If this value is zero or empty, Imposition Publisher 
will use the default value. 

Blocks 

This is used to select which blocks of an imposition to print. The 
default is All blocks. Other choices are: 

  

Use Range and the To and From fields to select a range of blocks.  
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Select Even or Odd and the To and From fields to print only the 
even or odd blocks within the given range. 

From 
Select the first block to print. The default is 1. If this value is zero 
or empty, Imposition Publisher will use the default value. 

To 
Select the last block to print. The default is all the blocks in the job. 
If this value is zero or empty then Imposition Publisher will use 
the default value. 

Mark Set 

This popup is used to choose the print mark set to use. All the 
mark sets are stored in the Marks folder. 

 

Edit… (Mark Set) 

This button is used to edit print marks settings. See the section 
Print Marks on how to create and edit print mark sets. 

There are different options that apply to the current print job. 
These are accessed on the other tabs of the Print dialog. 

Save Settings 

This button is used to save the Print dialog settings to the 
preferences as the default values.  

Cancel 

Cancels the Print Dialog without printing. 

Print/Save (return key) 

Click to print the job to a printer or to save the job to a file. 
Imposition Publisher sends the job to the device shown in the 
Printer: popup menu. 
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If the Print To File checkbox is on, the Print button will change to 
Save. You will be asked to name the output file. Any text entered 
in the Name field is used as the file name. 

Print Dialog Information Boxes 

Device Size 
This comment box on the left displays the dimensions of the 
printing device you are outputting to. It provides a useful check 
that your device is setup correctly. 

Block Size 
This comment box on the right displays the width and depth of 
the block, including the crop and other print marks if selected.  

Print Options 

The Print dialog has three additional panes, identified by the 
Options, Colour and Trims & Bleeds tabs. 

Options Tab 

 

The Options tab contains a number of general printing options. 
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Mirror Printing 
Turn this on to print the output mirrored. 

Negative Printing 
Check this on to print the output negative or inverted. 

One Block/Tile per File 
This option prints each block or tile piece as a separate file. For 
multiple RIP systems, this can reduces the time it takes to image a 
file.  

The following convention is used for naming the output files: 

For Blocks: file.X  for block X. 

For Tiles: file.X-Y  for block X and tile piece Y. 

One Block per Sheet 
If this is on, Imposition Publisher will only fit one block onto a 
sheet at a time, i.e. the automatic placement of several blocks onto 
one sheet is disabled. This is switched on automatically if printing 
Duplex. 

One Colour per Sheet 
Enabled only for Media Saving print jobs. If this is on, Imposition 
Publisher will always start a new sheet when it finishes processing 
all the pages of a single separation. 

Print While Processing 
Applies to One Block/Tile per File jobs only. If Print While Processing 
is on, Imposition Publisher prints each file as soon as they are 
ready. When One Sheet per File is enabled and Print While 
Processing is off, Imposition Publisher will impose the entire job 
before releasing it to the printer. 

Remove Downloaded Fonts 
This option removes the file's fonts when printing. This is useful 
for printing to low memory devices, such as old imagesetters, 
where fonts are stored on the RIP, as it can reduce the time taken 
to image a file. 
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Echo Messages to RIP 
This option enables PostScript job messages that may be visible on 
your Rip's console screen. 

Preserve Spread Pages 
Enabled only for Media Saving print jobs. This outputs double 
page spreads as 1 large page, rather than split them into 2 
individual pages. 

Scaling 
This is used to scale output in size. The scaling may be different in 
each direction.  

Shrink to Fit 
If this is checked, then Imposition Publisher will scale down the 
output automatically so as to fit on the selected print device. If this 
is on, the Horizontal and Vertical scaling options are disabled. 

Horizontal 
Enter the horizontal scaling between 1 and 1000%. 

Vertical 
Enter the vertical scaling between 1 and 1000%.  

Manual Duplex  
The Manual Duplex setting can be used on digital printers that are 
only capable of printing one side at a time. It specifies the 
orientation of the paper, so that when passed through the printer 
again the backs match the fronts. If this is set, Imposition Publisher 
will re-order the pages so that they output in the right order. 
Printing will pause after the first side and you will be prompted to 
re-insert the pages. 

This is only available to Fixed Page Size devices when the 
material can be fed back in, for example, a laser printer. 

There are for types of duplex printing available:  
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Type 1 

  

Type 2 

  

Type 3 

  

Type 4 
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Colour Tab 

The Colour tab is used to specify which colour separations to print 
and in what order.  

 

Order 
Choose in which order to print the colour plates. There are two 
choices: 

By Plate Numbers: Prints all colours for a particular plate 
number together. i.e. all colours for plate 1 will print first then all 
colours for plate 2 and so on. 

By Plate Colours: Prints all plates for a particular plate 
colour together. i.e. all plates for the first colour will print first 
then all plates for the next colour and so on. 

Plates 
Select any combination of colours to print. If the File List contains 
composite colour files, i.e. not colour-separated, this popup will be 
set to Ignore. 

All will print all the separations in the list. All colours in the list 
are selected. 
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Ignore will treat all pages as if there is no colour information. 
Composite versions of the standard print marks will be used. 

Selected indicates that only some of the colour separations are 
selected to print. Initially just the first colour is selected. It is then 
up to you to select any other colours. 
The list contains all the colour separations found in the job. Print 
any combination of colours by clicking on and off the relevant 
colours in the list.  

Trims & Bleeds Tab 

This tab is used to set up the trim values for Facing Pages, Step & 
Repeat and Media Saving printing. The trim values here can also 
be used to temporarily override the trims contained in a saved 
imposition. 

 

Bleed 

This popup controls the amount of bleed allowed. I.e. The distance 
that page information is allowed to extend beyond the trim page 
boundaries. There are three choices: 

Clip To Trims Information is allowed to bleed up to the start of 
the crop marks. This is the default setting. 



Chapter 2  User Guide 

117 

Clip To Page No information is allowed to bleed outside the page. 

Leave As Original Preserves the DTP application's bleed value. 

The Progress Monitor 

Every time you process  download  files, a progress monitor will 
appear to let you know how far you are through the task: 

  

The monitor shows: 

• What stage is being processed, whether it is headers, fonts, 
pages or printing. 

• A percentage (%) complete bar to indicate how far there is to 
go. 

• Whilst processing pages, there is a total for the pages 
processed and the blocks processed along with the current 
page being processed and which colour plate it belongs to.  

• If an error occurs processing or printing will be aborted and 
an error message will appear on screen. 

• If for any reason you need to keep these error messages, an 
error log file is automatically created in the Imposition 
Publisher installation folder. 

To abort the job click Cancel. 
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Previewing 

This allows you to preview the output on screen before sending it 
to the actual output device. 

Requirements 

• For PostScript jobs, Adobe Acrobat Distiller. 

• Adobe Acrobat or Adobe Reader. 

Note: In the Acrobat General Preferences switch off Display 
Open Dialog at Start-up. 

How It Works 

Imposition Publisher will process the files in the File List: Once a 
temporary file is created the Preview dialog is displayed. 

  

This shows the status of any files being previewed. 

If it is a PostScript job, the file is sent to Acrobat Distiller to convert 
into PDF. Once the PDF is created the Status line on the Preview 
window will change to Done. 

The PDF file is automatically displayed in Acrobat (or Adobe 
Reader). 
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When you have finished viewing the preview image, return to 
Imposition Publisher by clicking on the Preview dialog. You can 
then print or delete the imposed file or preview the PDF file again 
using the buttons on the right of this dialog. 

If One Block/Tile Per File is on in the Print Options tab of the Print 
dialog, there will be multiple output files. You can see the status of 
these files as the job progresses. The status conditions are Waiting, 
Previewing or Done. 

 

The first 3 buttons along the right side of the dialog act on the 
currently selected files in the list. Shift-click or control-click to 
select multiple files. 

Print 

Click this to print the selected files to the currently selected device. 

Preview 

Click this to preview the PDF files in Adobe Acrobat. 

Delete 

Click this to delete the selected files. 
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Done 

Click this to close the Preview window. This action cancels any 
files currently being processed by Acrobat Distiller. 

Media Saving 

Media Saving reduces the amount of film used when printing to 
an imagesetter. For instance, when printing A4 pages on a typical 
12 inch width imagesetter, the pages are normally output in a 
portrait orientation. Imposition Publisher will automatically print 
these pages with crop marks in a landscape orientation, resulting 
typically in a 35% saving in film. When it can fit several pages 
across the media, the savings are even greater. Another use for 
Media Saving is to print A3 pages with crop marks on 12 inch 
material, without having to spend hours creating these crop marks 
manually, as the crop marks produced by most DTP packages will 
not fit on 12 inch material. 

Media Saving also has the capability of optimising different sized 
pages. 

To use Media Saving 

1. Create a File List of the files you want to optimise. 

2. Select Print… from the File menu. 

3. Select Media Saving… from the Job Type popup.  
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4. Select the appropriate settings as for any other type of 
printing. 

5. Enter any trims required on the Trims & Bleeds tab. 

6. Click Print.  

When printing with crop marks, Imposition Publisher works out 
the optimum way to print the pages - given the current settings for 
Crop Mark Length, Block Spacing and Edge Trims. 

For example, for a device width of 306 mm and a page size of A4 
(210 mm x 297 mm), Block Spacing is set to 0 mm in Device Setup 
dialog, Edge Trims are set to 1.9 mm in the Trims & Bleeds dialog, 
crop marks are set to Calculate Automatically in the Print Marks, 
Edit Crop Marks dialog and the Crop Mark Length is set to 2 mm 
in the Preferences dialog. Media Saving will print the pages 
sideways with 2 mm crop marks spaced 1.9 mm away from the 
edges of the page.  

For smaller page sizes or wider material Media Saving may print 
several pages across the media.  
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If optimising different sized pages, they may be printed at 
different orientations to make full use of your device. 

 

Note: You may also want to reduce the Block Spacing value in the 
Device Setup dialog, to leave less space between adjacent 
pages. 
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Step & Repeat 

Step & Repeat allows you to print pages in a similar way to 
Media Saving but Imposition Publisher will fill up each output 
sheet with a repeat of each page in the File List. 

  

To Use Step & Repeat 

1. Create a File List of the files you want to Step & Repeat. 

2. Select Print… from the File menu. 

3. Select Step & Repeat… from the Job Type popup.  

4. Select the appropriate settings as for any other type of 
printing. Copies: controls the number of times each page is 
repeated. 

5. Enter any trims required in the Trims & Bleeds tab. 

6. Select Print.  

Crop Mark and Trim settings works the same as for Media Saving.  

Facing Pages 

Facing Pages allows you to print pages as facing pages, also 
referred to as Readers spreads. Although this can be done by some 
desktop publishing packages, using Imposition Publisher gives 
you more control over the crop marks and the amount of trim 
(space) between the pages. If you want to print pairs of pages 
together as they would appear in a magazine, for example, page 
16 with page 1, page 2 with page 15, and so on, then you should 
use a simple 2-up saddle stitched imposition. 
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Important: Normally, when producing the PDF or PostScript file, 
do not print the pages as spreads. Let Imposition 
Publisher do all the work. If you need to print pages 
as spreads from your DTP package, then follow the 
instructions in Creating Files. 

To use Facing Pages 

1. Create a File List of the files you want to print. 

2. Select Print… from the File menu. 

3. Select Facing Pages Printing from the Job Type popup. 

4. Select the appropriate settings as for any other type of 
printing. 

5. Enter any trims in the Trims & Bleeds tab. With Facing Pages 
Printing selected as the Job Type, the Trims & Bleeds tab 
allows you to specify a Gutter Trim value. 

 
6. Click Print. 

Facing Pages will print the pages with crop marks, only if crop 
marks are selected in the current Mark Set. The crop mark length 
is determined by the settings in the current mark set. 
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PREFERENCES  

The Preferences Dialog 
The Preferences dialog is used to specify defaults settings. The 
preferences are saved permanently, so they remain in effect the 
next time the program starts. 

General Preferences 

To display the General preferences tab, select Preferences… from 
the Edit menu, then click the General tab. 

  

Format  

This is used to specify the default setting for the Format popup 
that will appear in the New File List window. 
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Units 

This is used to specify the default units used throughout the 
program. The following choices are available: 

  

Show Recent Items 

Specifies how many recently opened documents are remembered 
by Imposition Publisher.  

Allow Multiple Documents 

Specifies whether or not more than one Imposition and Flatwork 
document can be opened at one time. 

Factory Settings 

Restores the default values to those at installation. 
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PDF Workflow Preferences 

Selecting the PDF Workflow tab in the Preferences dialog 
displays alerts settings and settings used when mixing PDF and 
PostScript files:  

  

The default settings should meet most needs. 

PostScript Level 

If your final output device is a Level 1 PostScript device then set 
the PostScript Level popup to 1. 

Output Format 

Determines the internal format of the PDF file created. Choose 
between Binary and ASCII format. 

For Temporary Files  

You can decide whether you wish to keep any temporary files that 
Imposition Publisher creates. In processing PDF files, temporary 
PostScript files are created in the ipscratch folder. 

Keep 
None of the temporary files are deleted. 
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Delete after each job  
Temporary files are deleted after each print job. 

Delete after each session 
Temporary files are not deleted until you quit Imposition 
Publisher. 

Factory Settings 

Restores the default values to those at installation. 

LICENSE DIALOG 
Use this dialog to re-enter your Dongle Number or Release Code if 
you upgrade your copy of Imposition Publisher. 

At the first launch the License dialog appears automatically. 
Otherwise it is accessed by selecting License… in the Edit menu: 

 

Version 

This allows you to switch versions of Imposition Publisher. The 
version that you have purchased should be shown on the flysheet 
that comes with Imposition Publisher. 
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Studio Professional 
This is the full version of the software and comes with all available 
drivers. 

Personal Professional 
This is the same as the Studio version but comes with a restricted 
selection of drivers: QuarkXPress (Win), InDesign, PageMaker, 
Corel, Example and PrePrint. 

Saver Professional 
This is a limited functionality version which is restricted to Media 
Saving only. 

Demo Version 
This is a demonstration version that has restricted functionality. 
You are not allowed to save any files and all output has the text 
Imposition Publisher Demo is written across the output. 

30 Day Evaluation 
This is a time limited evaluation version that has the same 
capabilities as the Studio Professional version, but will only work 
for 30 days after its first use. 

Windows Client 
This is the client part of the Imposition Publisher Client Server 
version. The client offers the familiar user interface on your 
workstation but the processing of the output files takes place on 
the server machine. 

Digital Version 
This is a full version of the software but has no Flatwork feature 
and only allows output up to 18”x13”.  

User Name 

Enter your name here.  

Company 

Enter your company here. 
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Dongle Number 

Enter your dongle number here. The dongle number is the 7 digit 
(USB) or 12 digit (parallel port) code on the dongle itself. For new 
copies or upgrades of Imposition Publisher there should be an 
accompanying sheet of paper with this number on it.  

Release Code 

Enter your release code here. The release code is a 12-digit number 
supplied with the software. It is unique to you and no one else can 
use it. For new copies or upgrades of Imposition Publisher there 
should be an accompanying sheet of paper with this number on it. 
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A TOUR OF THE MENUS AND SHORTCUT KEYS 
This section displays all Imposition Publisher menu commands 
and their associated shortcut keys. For more information, refer to 
the relevant section in the User Guide. The shortcut key 
combinations are displayed on the drop down menus. Anywhere 
there is an item with an underlined character, press the Alt key 
and the letter, to execute the menu command or button click. 

The File Menu 

 

New File List…  (Ctrl N) 

Creates a new untitled File List document and opens the File List 
window. 

New Imposition… (Ctrl I) 

Creates a new untitled Imposition document and opens the 
Imposition Setup dialog. 

New Flatwork… (Ctrl F) 

Creates a new untitled Flatwork document and opens the 
Flatwork window. 
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Open…  (Ctrl O) 

Opens previously saved File List, Imposition and Flatwork 
documents. 

Close (Ctrl W) 

Closes the active window. You can also close a window by 
clicking the close box on the right hand side of the window title 
bar. 

Save (Ctrl S) 

Saves any changes to the active window. If the File List, 
Imposition or Flatwork has not been saved before, you will be 
prompted to supply a file name and location. 

Save As…  (No Shortcut Key) 

Saves the active document into a new file. 

Page Setup… (Ctrl T) 

Opens the Page Setup dialog, which lets you specify the printer 
device size and offsets and enter alignment settings. 

Print… (Ctrl P) 

Opens the Print dialog. Only available if a File List is open. 

Download To Printer… (No Shortcut Key) 

Allows you to download a file to your RIP/output device. This 
can be a file created with Imposition Publisher or from another 
source. 

Recently Used Documents 

A list of recently opened File Lists, Impositions and Flatworks 
appears above the Exit menu item. 

Exit (Alt F4) 

Quits/exits Imposition Publisher. You will be prompted to save 
any changes to File Lists, Impositions and Flatworks. 
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The Edit Menu 

 

Undo  

Undo the previous action. 

Cut (Ctrl X) 

The selection will be cut (onto the clipboard). 

Copy (Ctrl C) 

The selection will be copied onto the clipboard. 

Paste (Ctrl V) 

The clipboard contents will be pasted at the insertion point. 

Clear (Delete) 

The selection will be deleted. Useful for removing files from the 
File List. 

Select All (Ctrl A) 

Selects all possible fields. For example, Select All can be used to 
select all the files in a File List or all pages on a Flatwork. 

License…  (No Shortcut Key) 

Opens the License dialog. You can enter a new release codes or 
change the version that you are running. 

Preferences… (Ctrl K) 

Opens the Preferences dialog. 
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The List Menu 

 

Add Files…  

Opens the file selection dialog to allow you to add files to the File 
List. Same as the Add Files… button. 

Add Blank (Alt B) 

Adds a blank page at the selection point in the File List. Same as 
the Add Blank button. 

Replace File…  (Alt F) 

Opens a file selection dialog to allow you to select a file to replace 
the current file in the File List. Same as the Replace File… button. 

Replace Pages…  (Alt P) 

Allows you to replace the selected page(s) with any other page in 
the current File List. Same as the Replace Pages… button. 

Inherit Page Size 

Remembers the page size of the first file added to the File List and 
applies this size to all subsequent files added. 

Inherit Page Margins 

Remembers the page margins of the first file added to the File List 
and applies these margins to all subsequent files added. 

Reduce Selection To 

Allows you to easily select particular elements within the File List. 
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For example, with several files selected in the File List, it is 
possible to select all the Black separations using this option. 

Separation Colour 

Changes the colour name of any selected separation(s) to any of 
the colour names available in the colour list. The colour list is 
edited using the Edit Colours… selection. 

Edit Colours… 

Allows you to add and remove colour separation names to the 
colour list of the current File List 

The Imposition Menu 

 

Setup… (Ctrl E) 

Allows the basic imposition information to be changed, including 
the finishing type. This option is only available if an imposition is 
open. 

Page Positions… (Ctrl G) 

Opens the Page Positions dialog allowing custom page offsets and 
rotations to be specified. This option is only available if an 
imposition is open. 

Rotate Page (Ctrl R) 

Rotates the selected page in increments of 90°. This is useful for 
calendar work. This option is only available if the Imposition 
window is active. 
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The Flatwork Menu 

 

New Sheet  

Adds an empty sheet to the current flatwork. 

Duplicate Sheet  

Duplicates the current sheet and adds it. The sub-menu gives 2 
option: 

Normal duplicate is a copy of the current sheet 

Mirror duplicate is a new sheet that mirrors all page positions on 
the current sheet for the correct Front/Back alignment. 

Delete Sheet  

Deletes the currently selected sheet. Disabled if there is only one 
sheet. 

Add Items…  

Places pages onto a Flatwork. See Add Items Dialog for more 
information. 

Flow Items…  

Re-flows or replace pages on a particular sheet once they have 
been added. Disabled if there are no pages on a sheet. See The 
Flow Items Dialog for more information. 
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Sheet Size…  

Sets the sheet size for the Flatwork. Usually this will be the same 
size as your output device. See The Sheet Size Dialog for more 
information.  

Show Rulers  

Displays the rulers in a Flatwork  

Show Crop Areas  

Displays the crop margin areas around each page. Denoted by the 
grey box/boundary. 

Show Crop Marks  

Displays the crop marks for each page. 

Show Enclosing Rectangles  

Displays the total enclosing box around each page, regardless of 
page orientation. Denoted by the purple outline. 

When a page is at a 90° interval the crop area and enclosing 
rectangle overlap. 

Show Guides  

Displays the guidelines in a Flatwork. 

Snap To Guides  (Ctrl Y) 

Snaps dragged pages to the nearest guideline intersection if this is 
on.  

Note: The corner that gets snapped is the one closest to the mouse. 
This is denoted by a red spot. 

Guide Lines…  

Sets up regular and custom guide lines. See The Guide Lines 
Dialog for more information. 
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The Layout Menu 

 

The items in the Layout menu position pages in the flatwork 
window.  

Move Forward  (Ctrl Shift F) 

Move the selected pages in front of the ones on top of them. 

Move To Front  (Ctrl ) ) 

Move the selected pages to the top. 

Move Backward  (Ctrl Shift B) 

Move the selected pages behind the pages underneath them. 

Move to Back  (Ctrl ( ) 

Move the selected pages to the bottom. 

Align Left Edges  

Align the left edges of the selected pages to the left edge of the left-
most selected page. 

Centre Horizontally  

Averages out the horizontal position of the centres of the selected 
pages and aligns them horizontally to this average.  

Align Right Edges  

Align the right edges of the selected pages to the right edge of the 
right-most selected page. 
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Align Top Edges  

Align the top edges of the selected pages to the top edge of the 
top-most selected page. 

Centre Vertically  

Averages out the vertical position of the centres of the selected 
pages and aligns them vertically to this average.  

Align Bottom Edges  

Align the bottom edges of the selected pages to the bottom edge of 
the bottom-most selected page. 

The Window Menu 

 

This menu displays all the currently open windows and allows 
you to easily switch between them by selecting them from the 
menu or by using the shortcut keys displayed. 

Close All 

Closes all open windows. 

Show/Hide Palette  

Displays or hides the Flatwork or palette. Only enabled if a 
Flatwork is the topmost window. 
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Help Menu 

 

Imposition Publisher Help  

Displays the Imposition Publisher Help file. See the Quick Start 
Guide or refer to this manual for further guidance. 

Browse the Web Site 

Connects to the Imposition Publisher home page using the default 
web browser. 

Mail the Support Desk 

Easily send an email to the Imposition Publisher Technical 
Support team using the default email client. 

Get the Latest Drivers 

Starts a download of the latest set of Imposition Publisher drivers. 

About Imposition Publisher… 

Displays the start up screen, which contains the Imposition 
Publisher version and build information. 

 

 

Please refer to the relevant sections of this chapter for all the other 
shortcut keys that are available within a dialog. 
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